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EcoStruxure 
Machine Advisor 

1. What is Edge Box HMI? 

With the Edge Box HMI, you can collect data from connected devices and forward it to 

Machine Advisor / AVEVA Insight / External Database with easy settings on software. 

 

 

 

 About this document  
 

This Edge Box HMI Quick Start Guide is intended for individuals using Edge Box HMI and its 

software for the first time. This document will help you quickly familiarize yourself with basic 

use of this product. 
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(C) PC with BLUE Open Studio 

(C) 

(B) 

 
USB Cable 

or 

 
LAN Cable 

BLUE Open Studio 

2. Preparation 
 

 

 Required environment  

Prepare the following development environment. 

(A) 

 
 
 
 
 
 

 

STM6000 Edge Box HMI 

PFXSTM6B00DIOT 
PC

 

 

 

 (A) STM6000 Edge Box HMI (PFXSTM6B00DIOT)  
 
 
 
 

 

 (B) Transfer Cable  

 
Optional USB transfer cable (PFXZUSCBMB2) or commercial 

USB cable (Type A to Micro-B). 

 
LAN cable (Ethernet cable) 

 
 
 

 

 
You PC (development environment) requires a HTML5 compatible browser (recommended: 

Google Chrome) to be installed. 

 
To create HMI project and transfer to the Edge Box HMI, your PC also requires BLUE Open 

Studio 2020 SP2 or later to be installed. BLUE Open Studio 500 tags Build Time License 

(PFXBOSBT500A) is sold separately. 
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Ethernet 

or USB 

 
 

 

This procedure is intended for users who are transferring a project to the Edge Box HMI for 

the first time. After this setup, you can access the Hardware Configuration page on a web 

browser to configure the Edge Box HMI. 
 
 

 

Hardware Configuration page 

on a web browser 
 
 

1. Connect Power Supply (DC24V) and check the status LED flashes orange. 

2. Connect PC via Ethernet cable or USB cable. 
 

 
 
 

3. When Ethernet (ETH1) is used, set IP address of your 

PC as follows. 

IP address: 192.168.1.*** 

(any address other than 192.168.1.80) 

Subnet Mask: 255.255.255.0 

 
When USB is used, the Edge Box HMI is recognized 

as Ethernet device on your PC and IP address is 

automatically configured. 

(Device name: Remote NDIS Compatible Device) 
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The password must meet the following requirements: 

Note: If you forget the password, note that you will not be able to reset it. To 

restore the product to its original state (at time of purchase), contact customer 

support. All user data in the product will be lost. 

 
 
 
 
 
 
 

 
5 

 
 
 
 

4. Open a web browser on your PC, and in the address bar enter the IP address of Edge 

Box HMI. 

https://192.168.1.80 (Ethernet) 

https://169.254.100.100 (USB) 

Hardware Configuration screen is displayed. 

5. When you access to the screen for the first time, you are requested to set a login 

password. 

Set a login password and click [Submit]. e.g. !Proface1234, and click [ Submit ] 

Note: The user name is “Admins” and cannot be changed 
 
 

 
 
 
 

Number of 

characters 

At least 8 single-byte characters, up to 64 characters 

Types of 

characters 

Use at least one of each of the following types of 

characters: 

• Uppercase letter (A-Z) 

• Lowercase letter (a-z) 

• Number (0-9) 

• Symbol (special character): ! # - = _ . 
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6. Enter the User Name, Admins and the newly created password, e.g. !Proface1234. Click 

[ Login ] 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
7. If you will be using an internet connection for cloud connectivity please proceed to step 8. 

If no internet/cloud connection needed please skip to step 12. 

8. Click [ ETHERNET] to display the Ethernet settings. 

9. Click [ Ethernet 2 ] to display Ethernet port 2 settings. 
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11 

 
 
 
 
 

10. Set the [ IP Mode] to [ Automatic ] or [ Manual] . [ Automatic ] for DHCP or [ Manual ] to 

enter in the necessary settings to allow internet access. 
 
 

 
 

11. Click [ Submit] to apply the ethernet setting. Note that the settings will only take effect 

after a reboot. [ OK ] to dismiss the Reboot Required dialog. 
 
 



STM6000 Edge Box HMI Quick Start Guide 

3. Hardware Configuration 

9
c v1.2 

 

 

 
 
 

12 
13 

 
14 

15 

16 

 
 
 
 
 
 

12. Click [ DOWNLOAD ]. 
 

 
13. Check [ Enable Project File Download ] 

14. Click [ Submit ]. Changes will take effect after a reboot. 

15. Click [ OK ] to accept the Reboot required message. 
 

 

16. Click [ SYSTEM ] 
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17 
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18 

19 

 
 
 
 
 
 

17. Set the [ Date ], [ Time ], [ Time-zone ] for your region. 
 
 
 

 

 
18. Click [ Submit ], changes will take effect after reboot. 

19. Click [ OK ] to dismiss the Reboot Required dialog. 
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20 

 
 
 

21 

 
 
 
 
 
 

20. Click the [ Reboot ] icon  at the top right of the web page. 

 

 
21. Click [ Yes ] in the Reboot dialog. 

 
 

 
22. After the Edge Box HMI has rebooted. Confirm the [ Ethernet 2 ] Settings, [ Enable Project 

File Download ] check box, [ Date ], [ Time ], [ Time-zone ] are as previously selected. 
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General 

 
 
 

In the Hardware Configuration screen, you can configure the following settings of the Edge 

Box HMI. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Function name Description 

INFORMATION You can check the product system version, runtime version, IP address, and so on. 

Also, if a System Error/Runtime Error occurs, you can check the error information in 

[Status] area. 

ETHERNET Configure Ethernet settings, which are required when communicating over Ethernet 

with connected devices, or when using functions that interact with a network PC, 

such as downloading project files. 

COM Select the serial interface communication method as either RS-232C or RS-422/485. 

For RS-232C communication, you can select to enable or disable VCC. 

USB When a USB device is connected to this product, use this function to safely remove 

the hardware. 

DOWNLOAD Enable to download project files and HMI Runtime to this product. Disable this setting 

for active run time operation. 

NOTE: Enable only when downloading project files or HMI Runtime. 

SITEMANAGER Set up when configuring a system that includes Pro-face Connect (sold separately). 

SECURITY Change the password. You can also perform operations such as check the previous 

login information and download that information. The downloaded security data file is 

"log.csv". 

SYSTEM [Date and Time] tab: set the internal clock of the product. You can also set up an 

NTP server to synchronize the clock. 

[Firmware Update] tab: update the firmware. 

[Factory Reset] tab: you can reset the product to the factory default settings. 

[Backup and Restore Configuration] tab: you can back up the settings in Hardware 

Configuration. The downloaded backup data file is "config.bin". You can also use the 

backup file to restore the settings of Hardware Configuration. 

 
NOTE: The following settings are not backed up or restored. 

• SECURITY tab 

• Date and Time tab in the SYSTEM tab 



STM6000 Edge Box HMI Quick Start Guide 

1
P
4

ublic v1.2 

 

 
General 

1 

1 

2 

3 

4. HMI Project Creation 
 

 Create Project  

1. Start up BLUE Open Studio 2020 SP2 or later and click [File] > [New]. 
 

 

2. Enter your [Project Name], e.g. EdgeBoxHMI QuickStart. 

3. Select Project type [Embedded BLUE Open Studio Basic] and click [OK]. 
 

 
4. Select resolution (you can use any) and click [OK]. 
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General 
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4. HMI Project Creation 
 

 Create Project  

5. Check or uncheck the “Do not automatically…” as appropriate. 

6. Click [Next] 
 

 

 

7. Clear the check box of [Enable Security System]. 

8. Click [Next] several times to skip Security Settings. 

9. Click [Finish] on the last dialog box. 
 

 

NOTE: You can configure security system later. So, skip here for quick start. 
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General 

2 

3 

1 

5 7 

4 

6 

4. HMI Project Creation 
 

 Create Screen and Tag  

1. Select [Graphics] Tab. 

2. Right-click on [Screens] and select [Insert]. 

3. Click [OK] on the Screen Attributes dialog. 
 

4. Double-Click [Native Symbols]. 

5. Expand [System Symbols]. 

6. Select [Sliders]. 

7. Select [slider01], the mouse icon should change to 
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General 

11 

4. HMI Project Creation 
 

 Create Screen and Tag  

8. With the mouse cursor still as click on the new screen’s tab, which will show the 

newly created screen again. 

9. Click anywhere on the screen to drop the slider01 symbol. 
 

 

10. Double-click the newly created slider01 symbol which will open the [Object Properties] 

dialog. 

11. Double-click the [TagName] [Value] field which will open the [Object Finder]. 
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General 

13 

14 

15 

17 

16 

4. HMI Project Creation 
 

 Create Screen and Tag  

12. Click [New]. 

 
 
 
 
 
 
 
 
 
 
 
 

13. Enter a [Name], e.g. MyData. 

14. Set the [Type] to [Integer]. 

15. Click [OK] to create the new tag. 

 
 
 
 
 
 
 
 
 
 

 
16. Select [Project] and select the newly created tag, e.g. MyData. 

17. Click [OK] to close the [Object Finder]. 

12 
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General 

19 

20 

4. HMI Project Creation 
 

 Create Screen and Tag  

18. Close the [Object Properties] window 

 

19. Click the [Save] Icon 
 

20. Set the [File name] to Main.scc then click [Save] 
 
 

18 
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General 

2 

4 

4. HMI Project Creation 
 

 Mobile Access Configuration  

1. Close all open tabs. E.g. Main.scc, Symbols 

2. Right-Click [Screens] and click [Save All as HTML] 
 

 
3. If prompted, click [Yes] 

 
 
 
 
 
 
 

 

3 

4. If prompted again, click [Ok] 
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General 

 
 
 
 
 
 

5 

 
 
 
 
 
 

6 

7 

4. HMI Project Creation 
 

 Mobile Access Configuration  

5. Open [Thin Clients] and double-click [Mobile Access] 

6. If prompted with a dialog, select [Yes], the [Mobile Access Configuration] is shown 
 

7. Click [Area Settings…] 
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General 

 
 

10 
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4. HMI Project Creation 
 

 Mobile Access Configuration  

8. Scroll down to the [Trend and Process Values] section 

9. Enter “MyData” for the [Tag Name] and the [Label]. 

10. Check the [Write] checkbox 
 

 
 

11. Scroll down to the [Screens] section. 

12. Select [main] from the first drop dropdown list. Type in the [Label] “Main” in the text box 
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General 

13 

4. HMI Project Creation 
 

 Mobile Access Configuration  

13. Click the [Save] icon to save the [Mobile Access Configuration] 
 

14. Close the [Mobile Access Configuration] tab. 
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General 

 

1 

 
 

 
3 

 

 
2 

 
 
 

The Edge Box HMI (model number: PFXSTM6B00DIOT) includes an HMI Runtime license 

(500 tags supported) and a Mobile Access license. There is no need to activate them. 

 
Since the Edge Box HMI does not have a display, you can use the Mobile Access feature to 

access the Edge Box HMI from a web browser on your computer (development environment). 

 
The following settings are required in BLUE Open Studio to enable transferring a project to the 

Edge Box HMI. 

 

 Install Runtime Files  
 

1. On [Home] tab of the ribbon, in [Remote Management] group, click [Connect]. 
 

2. [Target] tab, enter the [Target Station] [Host] IP address of the Edge Box HMI 

e.g. 192.168.1.80 (Ethernet cable) e.g. 169.254.100.100 (USB) 

3. Click [Connect] 
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General 

4 

5 

You’ll see the information 

in [Status] such as 

“Connected to …” 

6 

 
 
 
 

 Install Runtime Files  
 

4. If prompted, click [Yes]. 
 

5. If prompted again, answer either [Yes] or [No] as appropriate. 
 

 
 

6. After confirming that the Remote Management tool connected to the Edge Box HMI and 

its status is displayed, click [Install Runtime Files]. 
 
 

Note: It will take a while to install HMI Runtime. 
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General 
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4 

 

5 

5. Transfer V2020 
 

 Transfer Project Files  
 

1. In the [Remote Management] dialog, click the [Project] tab. In the [Local] box, you should 

see the location of the project that is currently open in your development environment. 

This is the project that is to be downloaded to the Edge Box HMI. 

2. Ensure that the [Status] is “Project is stopped”. If not, click [Stop] and wait for the status 

to change. 

3. Click [Download]. 
 

 
4. After the [Status] has changes to “Files were sent successfully”, click [Run] 

5. Click [OK] to close the dialog window. 
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6. Transfer V2023 and newer 

The Edge Box HMI (model number: PFXSTM6B00DIOT) includes an HMI Runtime license 

(500 tags supported) and a Mobile Access license. There is no need to activate them. 

 
Since the Edge Box HMI does not have a display, you can use the Mobile Access feature to 

access the Edge Box HMI from a web browser on your computer (development environment). 

 
The following settings are required in BLUE Open Studio to enable transferring a project to the 

Edge Box HMI. 

 Install Runtime Files  

1. On [Home] tab of the ribbon, in [Remote Management] group, click [Connect]. 

2. [Target] tab, enter the [Target Station] [Host] IP address of the Edge Box. 

Check Use TLS is mandatory. HMI e.g. 192.168.1.80 (Ethernet cable) 

e.g. 169.254.100.100 (USB) 

3. Click [Connect]  
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4. In the verify certificate dialog click [Yes] 

 

5. Log on to Target, Default user admin, password admin. Click [OK] 

6. Verify the Certificate again.  
 



STM6000 Edge Box HMI Quick Start Guide 

 

29  

7. Connected. Note these steps need to be completed within a defined time period, if not a 
connection cannot be made. 

8. After confirming that the Remote Management Tool is connected to the edge box, and the  

project is stopped [Project Tab]. Click [Install] to install the runtime files. 
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6. Transfer V2023 and newer 

 Transfer Project Files  
 

1. In the [Remote Management] dialog, click the [Project] tab. In the [Local] box, you should 

see the location of the project that is currently open in your development environment. 

This is the project that is to be downloaded to the Edge Box HMI. 

2. Ensure that the [Status] is “Project is stopped”. If not, click [Stop] and wait for the status 

to change. 

3. Click [Download]. 
 

 
4. After the [Status] has changes to “Files were sent successfully”, click [Run] 
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7. Accessing the HMI Screen using Mobile Access 

After transferring your HMI project to the Edge Box HMI, launch a web browser on your PC to 

access the HMI screen. 

i. Launch a web browser on your PC. 

ii. Access to https://<EdgeBoxHMI IP Address>/MA, e.g. 
https://192.168.1.80/MA 

iii. Enter ‘guest’ in username and Click [Logon]. 

https://192.168.1.80/MA
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4 

 
 
 
 
 
 
 
 
 

3 

 

 
iv. Click [Screens], then screen list that you configured in Mobile 

Access worksheet appears. 



STM6000 Edge Box HMI Quick Start Guide 

 

33  

7. Accessing the HMI Screen using Mobile Access 

5. Click screen menu item to see the screen. 
 

 
 

NOTE: You can go directly to the screen by specifying the screen name in URL. 

https://<EdgeBoxHMI IP Address>/MA/#screen=<Screen Name>&guestuser=1 

e.g. https://192.168.1.80/MA/#screen=main&guestuser=1 

https://192.168.1.80/MA/#screen%3Dmain%26guestuser%3D1
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8. EcoStruxure Machine Advisor Configuration 
 

 Overview  

 

The Edge Box HMI can use the MACHA driver to send tag data to EcoStruxure Machine 

Advisor. An internet connection is required. By default, tag data is sent when the tag value 

changes. 

 
NOTE: you can use the ForceTagChange() function to trigger the MACHA driver to send the 

tag value even when the value has not changed. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
EcoStruxure 

Machine Advisor 

Machine 

 
Server URL 

Token 

 
 

EcoStruxure Machine Advisor 

Machine Specific Data points 

 
 

Internet 
 
 
 
 
 
 
 

 
ETH2: 175.172.0.225 

 
 
 

 
PFXSTM6B00DIOT 

 
 

MACHA Driver 
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3 

3 
3 

 
 
 
 

 EcoStruxure Machine Advisor Machine Connection  

 
To establish a connection to EcoStruxure Machine Advisor you will need the following: 

• EcoStruxure Machine Advisor Account 

• Purchaser Configured in Organization settings. 

• Registered Machine 

• Server Address 

• Token 

 

1. Sign in to EcoStruxure Machine Advisor https://ecostruxure-machine- 

advisor.se.app/welcome 

2. Follow the steps shown in the tutorial video to create a new Registered Machine 

https://youtu.be/g4hNI0K62H0 

3. Select the machine and go to the configuration page [ Monitor ] -> [ Config ]. 
 
 
 

 

https://ecostruxure-machine-advisor.se.app/welcome
https://ecostruxure-machine-advisor.se.app/welcome
https://youtu.be/g4hNI0K62H0
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 EcoStruxure Machine Advisor Machine Connection  

 
4. Select Mode: [ Connect your machine ] 

5. Select Plan: Select your appropriate plan. For example, [ Pay As You Go ] 

6. Select Gateway: [ Custom ] 

7. Select Format: [ Tango ] 

8. Select Transport: [ HTTPs ] 
 

 

9. Click [ +New Token ], leave the duration as default (10 years) and [ Create ] to create a 

new token. 

 
 
 
 
 
 
 
 
 

 
10. Generate new token, check the “I confirm…” check box to generate a new token and click 

[ Yes ]. 
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 EcoStruxure Machine Advisor Machine Connection  

 
11. Copy the string in Server box and paste it on Notepad. 

12. Copy the string in Token box and paste it on Notepad. 
 
 
 
 
 
 
 
 
 

 

11 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

12 
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 BLUE Open Studio Project Settings  

 
1. Launch a Web Browser on your PC and Go to https://curl.se/docs/caextract.html 

2. Download the “cacert.pem” file. 

3. Rename the file as “macha.pem”. 

4. Copy “macha.pem” to the driver directory. For example for a default installation 

C:\Program Files (x86)\Pro-face\BLUE Open Studio 2020\Redist\IoTView\Linux\arm- 

gnueabihf-2.13-6.0.17\drv 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

2 

https://curl.se/docs/caextract.html
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 BLUE Open Studio Project Settings  

 
5. In BLUE Open Studio, {Project Explorer] -> [Comm] tab, right-click drivers and select 

[Add/Remove Drivers]. 

6. Locate the [DLL] called [MACHA] and click to select it, then click [Select >>]. 
 

7. Click [OK] to close the [Communication Drivers] dialog. 
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 BLUE Open Studio Project Settings  

 
8. Navigate to [ Project Explorer] -> [ Comm ] tab -> [ Drivers ] -> [ MACHA ] -> [ MAIN 

DRIVER SHEET ] 
 

 

9. Enter the [Tag Name] = My Data, [I/O Address] = I:200 and copy/paste the Station 

address from notepad into the [Station] field. 
 



STM6000 Edge Box HMI Quick Start Guide 

8. EcoStruxure Machine Advisor Configuration 

 

41  

10 

11 

12 

13 

16. Click [ OK ] 

14 15 

16 

 
 
 
 

 BLUE Open Studio Project Settings  

 
10. Right Click on [ MACHA ] and Select [ Settings ]. 

11. Set Prefix String: ANY, e.g. EdgeBoxHMIQuickStart 

12. Select JSON Format: [ Tango ] 

13. Click [ Authentication ] 
 

14. Copy URL and overwrite Station field. 

15. Copy Token (after “Authorization;”) and overwrite the Password field. 
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17 

 
 
 
 

 BLUE Open Studio Project Settings  

 
17. Click [ OK ] to close the MACHA driver settings. 

 

18. Transfer both the Runtime (to include macha.pem) and Project files to the Edge Box HMI 

as shown in Section 5. 
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 Overview  

 

The Edge Box HMI can use a Trend Logger worksheet to communicate to an AVEVA Insight 

account. A Data source definition is required in AVEVA Insight. Trend Logger data is logged 

every 5 seconds. Accumulated data is forwarded to AVEVA Insight every 15 seconds. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

AVEVA Insight Data Source 
 

AVEVA 

Insight 

Data Source 

 
Endpoint URL 

Token 

 

Forwarder – 15 seconds 

 
 

Internet 
 
 
 
 
 
 
 

 
ETH2: 175.172.0.225 

 
 
 

 
PFXSTM6B00DIOT 

 
 

 

Scheduler – 5 seconds 

 

 
Trend Logger 

Worksheet 
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4 

2. Navigate to AVEVA Insight Suite -> [ Administration ] 

2 

3 

5 

 
 
 
 

 AVEVA Insight Connection  

To establish a connection to EcoStruxure Machine Advisor you will need the following: 

• AVEVA Insight Account and Solution 

• AVEVA Insight Data Source 

• Upload Endpoint 

• Authentication Token 

 

1. SIGN-IN to AVEVA Insight ( https://insight.connect.aveva.com ) and create a solution. 
 

 
 

3. Navigate to [ Data Sources ] 

 

 
4. Click [ + ] icon and select [ CSV/JSON ] 

 
 
 
 

 
5. Enter Name, Location Name, etc. and click [OK] 

 

https://insight.connect.aveva.com/
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 AVEVA Insight Connection  

6. Copy the text in “Upload endpoint” field and “Token” field and paste them into Notepad, 

then click [ CLOSE ] 
 
 
 
 
 

6 
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 BLUE Open Studio Project Settings  

1. [ Project Explorer ] -> [ Tasks ] Tab 

2. Right-Click Scheduler -> Click [ Insert ] 
 

3. In the first row [ Time ] Field enter 00:00:05 

4. In the first row [ Tag [ Field enter “TrendLoggerTrigger” if prompted to create a new tag 

click [ Yes ], then click [ OK ]. 

5. In the [ Expression ] field enter “Toggle(TrendLoggerTrigger)”. 
 

 

6. Save the worksheet. If prompted, enter “1” as the [ Sheet number ] 
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 BLUE Open Studio Project Settings  

7. Close the [ SCHED001.SCH ] worksheet 

8. Right-Click Trend Logger -> Click [ Insert ] 
 

 
9. Change the [ History Format ] to [ Historian ]. 

10. Click [ Historian Configuration ] 
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 BLUE Open Studio Project Settings  

11. Set the [ Connection Type ] to [ AVEVA Insight (CSV/JSON) ] 

12. Copy the Endpoint URL from notepad and paste overwriting the [ Upload Endpoint ] 

13. Copy the Token from notepad and paste overwriting the [ Authentication Token ] 

14. Click [ OK ] to accept the historian settings. 
 
 

11 
 
 
 
 
 
 
 
 
 
 
 

 

12 
13

 

 
 
 
 
 
 

14 
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15 

16 

17 18 

9. AVEVA Insight Configuration 
 

 BLUE Open Studio Project Settings  

15. Set the [ Description ] to “AVEVA Insight” 

16. Replace [ Second ] with [ TrendLoggerTrigger ] 

17. Set the first row [ Tag Name ] to [ MyData ] 

18. Set the first row [Historian Tag ] to [ MyData ] 
 

19. Save the [ Trend Logger ] worksheet, if prompted set the [Sheet number] to 1. 
 

 
20. Transfer the project files to the Edge Box HMI as shown in Section 5. 
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10. Database Configuration 
 

 Overview  

 

The Edge Box HMI can use a Trend Logger worksheet to log data to a Microsoft SQL Server 

Database. Trend Logger data is logged every 1 seconds. Each time the trend logger sheet is 

triggered data is sent via the Studio Database Gateway which contains the communication 

driver for Microsoft SQL Server. The Studio Database Gateway establishes a connection to 

the database on behalf of the Edge Box HMI and logs the data to a table called TREND002. 
 
 

Microsoft SQL 
Server Database 

MyPCName\SQLEXPRESS 

 
Database Name 

 
Username 

Password 

 

Studio Database Gateway 

PC IP: 192.168.1.70 

Port 3997 Open 

 

 

 

 

 

 

 

 

 

Eth1: 192.168.1.80 

 

 

PFXSTM6B00DIOT 

Microsoft SQL Server 
Database 

Studio Database Gateway 

 
Trend Logger 

Worksheet 

L
A
N
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Edge Box HMI 
Connection 

Firewall(s) 
Port 3997 Open 

Studio Database 
Gateway 

 

 

 Overview  
 

 

A simple configuration would have both the SQL Server instance and the Studio Database 

Gateway installed on the same Windows PC. The PC is configured with an IP Address of 

192.168.1.70 

 
For example, SQL Server 2019 installed on a Windows 10 PC with the following: 

– Path to SQL Server = PCNAME\SQLEXPRESS 

– Database name = EdgeBoxHMI 

– Mixed mode authentication with a local user account as db_Owner for the 

EdgeBoxHMI database and login rights 

• Username = EdgeBoxHMI 

• Password = !Proface1234 

 
On the same PC as SQL Server the Studio Database gateway is installed and running on port 

3997. 

 
PC Firewall(s) open for port 3997 for access to the Studio Database Gateway. 

 

PC IP: 192.168.1.70 
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2 

3 

 

 

 Create a SQL Database  

This procedure assumes there is not an existing database for use with the project. 

 

This database setup is for demonstration purposes only. Please ensure the appropriate 

security measures are taken before deploying any database in a production 

environment. 

 

1. Start [ Microsoft SQL Management Studio] 

2. If you followed the previous section’s instructions and the current Windows user account is 

an administrator for SQL, leave the [ Connect to Server ] dialog settings as default and 

click [ Connect ]. If not, enter the correct Server name and Authentication details. 

3. [ Object Explorer ] -> [ Databases ] right-click [ Databases ] and click [ New Database… ]. 
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6 

 
 
 
 

 Create a SQL Database  

4. Enter the Database name as “EdgeBoxHMI” 

5. Click [ OK ] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. [ Object Explorer ] -> [ Security ] -> [ Logins ] right-click [ Logins ], click [ New Login… ] 

 

4 

 
 
 
 
 
 
 
 
 
 
 

5 
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12 7 

8 

9 

10 

11 

 
 
 
 

 Create a SQL Database  

7. Enter a Login Name: EdgeBoxHMI 

8. Select [ SQL Server Authentication ] 

9. Enter a password and confirm the password: !SE1234 

10. Uncheck [ Enforce password policy ] 

11. Change the [ Default Database ] to [ EdgeBoxHMI ] 

12. Select the [ User Mapping ] page. 
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13 

 

 

 

 

 

 

14 

15 

 
 
 
 

 Create a SQL Database  

13. Check [ Map ] for the [ EdgeBoxHMI ] database 

14. Check [ db_owner ] 

15. Click [ OK ] 
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4 

 
 
 
 

 Studio Database Gateway Installation  

To allow the HMI runtime running on the Edge Box HMI to communicate with SQL Server the 

Studio Database Gateway needs to be installed on a Windows PC on the same network as the 

Microsoft SQL Server. For an easy demonstration configuration, install the Studio Database 

Gateway on the same Windows PC as the Microsoft SQL Server Database. 

 

If BLUE Open Studio is already installed on the Windows PC, the Studio Database Gateway is 

already installed in the BLUE Open Studio BIN directory. The default path would be: 

C:\Program Files (x86)\Pro-face\BLUE Open Studio 

2020\Bin\DatabaseGateway\StADOSvr.exe 

Skip to STEP 11 if BLUE Open Studio is already installed. Otherwise install the Studio 

Database gateway by starting at STEP 1. 

 

1. If not already installed on the Microsoft SQL Server Windows PC, install .NET Framework 

3.5 via [Turn Windows features on or off ]. 

2. On the BLUE Open Studio development PC copy the [ GatewaySteup.exe ] from 

C:\Program Files (x86)\Pro-face\BLUE Open Studio 

2020\Redist\DatabaseGateway\GatewaySetup.exe to the Windows PC that has 

Microsoft SQL Server installed. 

3. Run the GatewaySetup.exe 

4. If prompted to install redistributables, click [ Install ] 
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6 

7 

 
 
 
 

 Studio Database Gateway Installation  

5. Click [ Next ]. 

 
 

6. Enter a [ User Name ] and [ Company Name ] 

7. Click [ Next ] 
 
 
 

 
 
 
 
 
 
 

 
5 
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8 

 
 
 
 
 
 
 

 
9 

 
 
 
 

 Studio Database Gateway Installation  

8. Click [ Next ]. 
 

 

 
9. Click [ Next ] 

 
 



STM6000 Edge Box HMI Quick Start Guide 

10. Database 
Configuration 

 

59  

 
 
 
 

 Studio Database Gateway Installation  

10. Click [ Install ]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. Create a firewall exception for the Studio Database gateway which uses port 3997. For 

example configure Microsoft Windows Defender Firewall and any other security software 

that would block communication. 

12. Set the IP Address of the Windows PC that is running the Studio Database Gateway to 

192.168.1.70 
 

 
 
 
 
 
 
 

 
10 
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 Studio Database Gateway Installation  

13. Start the Studio Database Gateway Manually or set the program to autostart on Windows 

log in using a shortcut in the startup folder, task scheduler, registry or other method to auto 

start a program in Windows. 

 

To manually start the Studio Database Gateway on a Windows PC without BLUE Open 

Studio installed, execute: C:\Program Files (x86)\Studio Database Gateway 

2020\StADOSvr.exe 

 

To manually start the Studio Database Gateway on a Windows PC with BLUE Open 

Studio installed, execute: C:\Program Files (x86)\Pro-face\BLUE Open Studio 

2020\Bin\DatabaseGateway\StADOSvr.exe 

 

14. Confirm the Studio Database Gateway is running by checking for the Icon in the notification 

area of the taskbar. 
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1 

 

 

 

 

2 

3 

 
 
 
 

 BLUE Open Studio Project Settings  

1. [ Project ] menu -> [ Options ] 

2. Click [ Default Database ] 
 

3. Click [ … ] 
 

4. Select [Microsoft OLE DB Provider for SQL Server ] and click [ Next ] 
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 BLUE Open Studio Project Settings  

5. Enter the server name so that it matches the SQL server instance name. 

6. Enter the user name and password if different (user name = EdgeBoxHMI, password 

= !SE1234) 

7. Check [ Allow saving password ] 

8. Enter the database if different (EdgeBoxHMI) 

 

10. Click [ Advanced ] 

11. Enter the Database Gateway Host and Port if different (Host = 192.168.1.70, Port = 3997) 

9. Click [ OK ] 

5 5 

6 

7 

8 

9 
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16 

15 

 
 
 
 

 BLUE Open Studio Project Settings  

14. Click [ OK ] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
15. [ Project Explorer ] -> [ Tasks ] Tab 

16. Right-Click [Trend Logger ] -> Click [ Insert ] 
 

 
 
 
 
 
 
 
 
 
 

14 
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17 

18 

19 

20 

21 

 
 
 
 

 BLUE Open Studio Project Settings  

17. Change the [ History Format ] to [ Database ]. 

18. Click [ Database Configuration ] 
 

 
19. Confirm the Database setting are correct. 

20. Leave [ Table ] Settings as default 

21. Click [ OK ] 
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22 

23 24 

27 

 
 
 
 

 BLUE Open Studio Project Settings  

22. Set the [ Description ] to “Database”. 

23. Enter “MyData2” into the first row [ Tag Name ] column. If prompted to create the tag 

select [ Yes] and [ OK ] 

24. Enter “MyData” into the first row [ Field ] column. 
 

 
25. Save the Trend Logger worksheet. If prompted, enter 2 as the [ Sheet number ]. 

 

 
26. Close the [ TREND002.TRD ] tab. 

27. In the [ Project Explorer ], Right-Click [ Math ] and Click [ Insert ] 
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28 

29 30 

 
 
 
 

 BLUE Open Studio Project Settings  

28. In [ Execution ] enter “1” 

29. Enter “MyData2” into the first row [ Tag Name ] column. 

30. Enter “MyData” into the first row [ Expression ] column. 
 
 

 

31. Save the Math worksheet. If prompted, enter 1 as the [ Sheet number ]. 
 

 
32. Close the [ MATH001.MAT ] tab. 

33. Transfer the project files to the Edge Box HMI as shown in Section 5. 
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11. Pro-face Connect Configuration 

When using a PC or tablet to display and operate HMI products installed in remote locations, it 

is necessary to build a system that prevents unauthorized access by external entities. By 

installing Pro-face Connect (sold separately), you can build a secure remote access system. 

 
Pro-face Connect consists of our products on the work site (SiteManager), computers or 

tablets in the office (LinkManager), and a server to connect them (GateManager). 

 
This section describes how to set up SiteManager. 

 

 How to set up  
 

1. Log in to [Hardware Configuration]. 

2. Open [SITEMANAGER] tab and select [Enable Remote Management] check box. 

3. Enter IP address of GateManager you want to access and the password (token) 

to connect to GateManager. This information can be found at the bottom of 

GateManager X.509 certificate emailed to you from GateManager. 
 

4. In Appliance Name, enter the name of the target device (the name of SiteManager). The 

name set here is displayed on GateManager. 

5. If required, enter the proxy server IP address, account name and password. For proxy 

server information, consult your network administrator. 

6. Click [Submit]. 

7. Click [Reboot] icon in the top-right corner of the screen. The product is restarted. 

NOTE: 

For more information about Pro-face Connect, refer to our website. https://www.pro-face.com 

When you delete the registered SiteManager from GateManager, you need to initialize SiteManager and 

reassign the license. Click [Reset to Default] and request the GateManager administrator to reassign the license. 

(You cannot use the same license. Reissuing a license will take 24 hours.) 

http://www.pro-face.com/

